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1. Introduction 

- This wellbore thermal model, GTEMP1, has been jointly developed by Maurer Engineering Inc. 

and the Department of Modem Mechanics of the University of Science and Technology of C h i  (USTC) 

- 
- 

- as pan of the DEA-67 project. This program, written in Visual Basic, is designed for use with IBM 

1 

Users not wishing to read the User's Manual can go directly to Section 7,s -GTEMPl 1 
QUICK START @age 7-12) to calculate the example shown in CHAPTER 7. 

PARTICIPANTS USING INTERNATIONAL KEYBOARDS SEE A PPEIVDLX A. 

compatible computers with Microsoft Windows 3.0 or later version. 
- 

-- - GTEMPl is a downhole thermal simulation model developed for improving the prediction of high 

- downhole temperatures. The program models natural and forced convection and conduction within the 

wellbore and heat conduction within the surrounding rock formation. A variety of well operations can - -- 
be modeled including injection, production, forward and reverse circulation with liquid, gas, or two- 

phase steam. The windows-style program graphically displays the output data. - -  
1.1 MODEL DESCRIPTION 

The key features of GTEMPl are listed below. 

1.1.1 General Features 
1. Microsoft Windows environment 
2. Supports English, metric, and customized unit systems 

3 .  Supports both color and monochrome monitors 

4. Handles boreholes of any inclination from vertical to horizontal 

5 .  Handles up to 20 flow periods of operation 
6. Results, data, and graphs can be output to screen, printer, and disk files 

7. Gmphically shows temperatures (and pressures) in tubing, annulus, and other selected l d o m  

8.  Calculates temperature gradients in multilayer rock formations 

9. Handles mixing and cooling in the surface circulation system 

1.1.2 Calculation Features 

1. Fully-transient heat conduction 
a. wellbore flowing stream 

b. rock formation 

2. Wellbore fluid flow options 

a. injection and production 

1-1 01997 Maurer Engineering Inc. 



b. forward and reverse circulation 
c. inlet temperature, flow rate, and fluid property change 
d. multiple fluids in wellbore 
e. two-phase steam injection and production 

3. Well completion options 
a. casing size, weight, and setting depth 
b. variable tubing area 

c. length of cement columns 
d. annulus packer fluids 

The Output Window is a compilation of "child" windows of text reports and graphs as 

explained in Section 6.1.3. 

~., ,. 
No warranty or representation is expressed or implied, with respect to these programs or 

??ZI&umentation, including their quality, performance, merchantability, or fitness for a particular purpose. 

- - 1.3 COPYRIGHT 

Participants in DEA-67 can provide data output from this copyrighted program to third parties and 

can duplicate the program and manual for their in-house use, but cannot give copies of the program or 

manual to third parties. 

01997 Maurer Engineering Inc. 



2. Theory 

- 2.1 GENERAL 

2.1.1 Nomenclature 
A = cross sectional area of tubing or azimuth of well lateral 

A, = cross sectional area of annulus 

B = buoyancy 

C, = drag coefficient 

C, = specific heat capacity - 
~~~. 

~ ~~ 

D = hydraulic diameter of the duct 
-~ - ~A 

E - - energy - 
~ - F = drag 

Fr = Froude number - 
f = friction factor 

G = mass flux density - h Gr = Grashof number 

g = acceleration of gravity 

H = enthalpy 

specific enthalpy or conversion coefficient 

inclination of well lateral 

radial level index 

axial level index 

thermal conductivity 

bubble flowlslug flow boundary number 

transition flowlmist flow boundary number 

slug flowltransition flow boundary number 

M = consistency index of power-law fluid 

- m = exponent of power-law fluid or mass flow rate 

Nu = Nusselt number 

P - - pressure 

Pr = Prandtl number 
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Q = volume flow rate 

9 = heat flow rate 

R = universal gas constant 

Re = Reynolds number 

r = radial coordinate or relative coefficient 

T - - temperature 

t = time 

U = thermal conductance 

V = volume 

v = velocity 

W =  gravity 

Z = compressibility factor 

z = axial coordinate 

p = volumetric coefficient of thermal expansion 

Y = slug flow liquid distribution coefficient, or ratio of specific heat, or strain rate 
for non-Newtonian fluid 

6 = measure of roughness 

8 = duct inclination from vertical 

K = thermal diffusivity 

P = viscosity 

pe, = effective viscosity 

PP = plastic viscosity for Bingham fluid 

v = kinematic viscosity 

P = density 

u = surface tension between water and steam 

T = frictional gradient term; shear stress 

To = yield point for Bingham fluid 

'3 = void fraction of the gas 

Subscripts 

g = gas 

I = inner; grid number along radial direction 

j = grid number along axial direction 

o = outer 
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s = solid 

t = total 

w = water 

1 = inlet condition 

2 = exit condition 

2.1.2 Wellbore Descrivtion 

Figure 2-1 shows a well completion for an injection or production well; Figure 2-2 shows 

a well completion for a circulation well. In these figures, the tube in the center is the tubing or drill 

pipe; the casings outward in order are: production casing, intermediate casing, surface casing, conductor 

pipe, and finally borehole. Outside the borehole is rock formation. 

INJECTED FLUID 

1 

.LYNULUS FLUID ANNULUS FLUID 

Figure 2-1. Wellbore Completion Model for 
Production and Injection 

GROUND LEVEL 

Figure 2-2. Wellbore Completion Model for Circulation 
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2.1.3 Numerical Grid 
The model's grid system is illustrated in Figures 2-3 and 2-4. Three temperatures are 

computed in the wellbore at each depth (Figure 2-3). Radial boundaries of mathematical cells are located 

at the well centerline, at the outside surface of the tubing or drill pipe, and at the first casing string 

(production casing). The location of the outer boundary of the third cell is the radial position outside 

of the wellborelrock interface. The distance from the borehole wall to the outer boundary is equal to 

the distance from the outside of the first casing string to the borehole wall, i.e., the centerline of the third 

cell is located at the well and rock interface (the radial location of the third temperature node). The first 

node is for fluid in the tubing or drill pipe, which represents the flowing production, injection or 

circulating fluid temperature, or simply a temperature near the center of the well during shut-in. The 

second node is for fluid in the annulus, which represents the annular fluid temperature during circulation. 

". -~ ~ ' . < ~  
~ ~ 

~ -~ ~ The heat conducted along the well axis in the wellbore is ignored. Axial step length is 
- ' ~~~ selected to be 200 ft, or specified by the user, and radial step length is generally a few inches to a few 

-~ . 
f ee t .  Axial temperature gradients are much less than radial temperature gradients for most applications. 

~ -~ 

r'--::~luid and rock cells are selected for computing the node temperatures as shown in Figures 2-3 and 2-4. 

- 

- For thermal modeling of horizontal wells and deviated holes, it is reasonable to assume that 

the trajectory of a wellbore is on a plane. It is only necessary to compute the temperature on a plane that 

is - perpendicular to the trajectory plane. 

CELL. BOUNDARY --- 

I--- R ----I- R ------I 
Figure 2-3. Mathematical Cells in Wellbore 
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- - Figure 2-4. Mathematical Grid for Formation 

2.1.4 Solids Pro~ertie~ - 
Material properties of solids in and around a well must be determined to properly model 

heat flow. Solids that must be modeled are cement, rock, and steel. Because thermal properties may - not be significantly different between two types of the same material, GTEMPl presently uses only one 

set of properties each for cement and steel. 

- 
Thermal properties required are density, specific heat capacity, and thermal conductivity. 

All solids properties are treated as constants. Table 2-1 lists the properties initially assigned 

to each solid. The user may change the values for rock and steel in the input data windows, if necessary. 

TABLE 2-1. Thermal Properties of Solids 

MATERIAL (LBM/FT') CAPACITY (BTU/LBM-OF) : (BTU~HR-FT- "F) 

CEMENT 104 0.20 0.60 
~ ~ ~ . . ~ ~ ~ - ~  . . . ~ ~ ~ ~ ~ ~ ~ . . .  . ~~~. . . ~ ~ ~  ~~ . ~ .  ~ 
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2.1.5 Operational Outions 

There are seven operational options available in the model that are listed below: 

1. Liquid Forward Circulation: 

Predicts temperatures for forward circulation with liquid. Fluid enters the well at the 
surface, travels down the tubing, and returns up the annulus to the surface. 

2. Liquid Reverse Circulation: 

Predicts temperatures for reverse circulation with liquid. Fluid enters the well at the 
surface, travels down the annulus, and returns up the tubing to the surface. 

3. Liquid Injection: 

Predicts temperatures for fluid injection. Fluid enters the well at the surface, travels down 
the tubing, and flows into the rock formation with no flow in the annulus. 

- -~ - == ~~.- 
-? . ~-v- -. 

4. Liquid Production: 

- - - ~ 

Predicts temperatures for fluid production. Fluid enters the well at the bottom and 
- -~ travels up the tubing to the surface with no flow in the annulus. 

~- 5. Gas Forward Circulation: 
-~~ -- 

Predicts temperatures and pressures for forward circulation with gas. Gas enters the 
. - A~~ well at the surface, travels down the tubing, and returns up the annulus. 

6 .  Steam Injection: 

Predicts temperatures and pressures for two-phase steam injection. Steam enters the 
well at the surface, travels down the tubing, and flows into the rock formation with no 
flow in the annulus. 

7. Steam Production: 

Predicts temperatures and pressures for two-phase steam production. Steam enters the 
well at the bottom and travels up the tubing to the surface with no flow in the annulus. 

2.2 LIQUID INJECTION, PRODUCTION, AND CIRCULATION 

2.2.1 Fluid Properties 

Material properties of the fluids in a well strongly influence the heat transfer between the 

well and rock. Fluid properties that must be defined in thermal simulation include density, viscosity, 

specific heat capacity, and thermal conductivity. 

Fluid viscosity strongly affects convection heat transfer. The power-law and Bingham fluid 

models are used to compute viscosity for non-Newtonian fluids present in most wells. 

Rheologic properties of high-solids muds and weighted muds (specific gravity greater than 

1.5) are approximately those of a Bingham fluid. Properties of low-solids muds and diluted muds are 

similar to those of a power-law fluid. Effective viscosity is defined as the ratio of the shear stress to the 

shear strain rate, y ,  
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peff = M y m '  (Power-law fluid) (2- 1) 

- pCfi = pp + ro/y (Bingham fluid) (2-2) 

where M is the consistency index, m is the exponent, p, is the plastic viscosity (or coefficient of - rigidity), and r, is the yield point. Shear strain rate (y) can be calculated from the fluid properties, fluid 

volume flow rate, and well geometry. 

- 
If viscometer readings b, R,,, R,,, and R,, are the only data available, the effective 

viscosity may be calculated from these readings. - 
Temperature is an important variable for determining fluid viscosity. All fluid properties 

. - a ~ ~ - . ~  . 
--areassumed in the model to be measured at 70°F. The impact of temperature changes on viscosity is - 

auComatically updated during calculation. 
-~ ~ 

- G- Specific heat capacity is used to determine sensible heat and energy accumulation in a fluid. - 
The value of specific heat capacity for a particular fluid is related to the solids fraction in the fluid. It 

- 

is assumed that all fluids are derived by adding solids to water. Solids fraction is computed as follows: - C- 

SF = 0.00508(p - 8.33), (for 8.33 < p < 10.3) 

- (2-3) 

SF = 0.0317(p - 10.3). (for p > 10.3) 

where p is the fluid density in Ibmlgal. Having determined the solids fraction, specific heat is computed: - 
- where c is in BTUIlbm-OF. 

Thermal conductivity controls the conduction of heat in the radial direction through the - fluid. Like heat capacity, it is computed from the solids fraction as defined in Eq. 2-3. 

K = 0.399 + 9.60SF - 
where K is in BTUIhr-ft-OF. 

- 2.2.2 Coudin? Rock and Well 

A thermal conductance must be formulated to describe the transfer of heat between the - wellbore and rock. When heat flows between the rock and well, it must pass through various 

combinations of steel, cement, fluid, and rock. Conductance is computed from the well geometry and 
P- - the properties of these materials. Heat passes from temperature nodes j,2 to j,3 through a composite 
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radial system of various materials (Figure 2-3). The rate of heat flow through such a system may be 

written as 

q = UAzAT 

where the thermal conductance U is 

This particular formulation is for fluid flowing inside a pipe with convection coefficient h and thermal 

conductivities, k, ,  k,, etc. k, may be the conductivity of steel, k, may relate to the natural convection 

occurring in the fluid in one of the annular regions, and h is the convection coefficient discussed in the 

next section. 

2.2.3 Convection Coefficient 
- - - 

Convection in wellbore fluids can significantly influence the rate of heat transfer from a well 

to-the surrounding rock formation. When fluid flows past a solid wall surface, heat transfer between 

fluid and solid surfaces is called convection heat transfer. The rate of heat transfer through a solid 

surface is 

q = hAT (2-8) 

where AT is the temperature difference between the fluid and solid. The convection coefficient may be 

computed from 
K h = Nu- 
D 

where D is the pipe diameter, K is the thermal conductivity of the fluid, and Nu is the Nusselt number. 

The Nusselt number is a measure of the heat flow rate at the fluidlsolid interface, which is related to the 

Reynolds (Re) and Prandtl (Pr) numbers (Gebhardt, 1961) 

Nu = 
(f/8) RePr (Pr > 100) 

1.2 + 11.8(Pr - 1 ) ~ r  ~0.33(f/8)1'2 
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- 
where f is the nondimensional friction factor. This friction factor is related to the Reynolds number. 

f = -  64 (Re < 2000) 
Re 

f = 0.013 (Re > 350000) - 
The rate of heat transferred across the annular region is increased by natural convection, 

- which can be expressed in terms of an effective thermal conductivity, K,,. The effective thermal 

_q~xductivity may be calculated from 
~. . . -- . 

~ - -  
~ ~~ 

~~ ~ ~ ~~ ~~- - ~ ~- 

where the Grashoff number, Gr, is defined by 

where p is the volumetric coefficient of thermal expansion, AT is the temperature difference across - 
annulus, and g is the acceleration of gravity. 

2.2.4 E n e r g v c e  in a Flu - id Cel! 

Energy in a fluid cell must obey the first law of thermodynamics, that is, energy must 

balance. This law leads to an equation of the form 

This equation can be written for every position of j,i in the wellbore to yield a system of simultaneous 

linear algebraic equations. The unknowns are the temperatures at each node at time step n+ 1 for a total 

of 3N, equations and unknowns, where N, is the number of nodes in the vertical direction. 

2.2.5 merw Balance in a Rock CeU 

Energy balance is also required for each cell containing rock. This requirement is met by: 
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Equation 2-15 may be applied to all nodes in the formation to produce a system of (N,-3)XN, 

simultaneous algebraic equations, where N, is the number of nodes in the radial direction. An equal 

number of unknowns exist for temperatures at the nodes. 

2.2.6 Solution Scheme 
As described in previous sections, Eqs. 2-14 or 2-15 may be applied to every temperature 

node to form a system of simultaneous linear algebraic equations. These equations can be solved for 

finding the new temperature at each new time step, n+  1. . 

A Gauss-Seidel iteration is employed to solve the equations to determine the new 
~ - . -  - - ~  

- 1-:'teGeratures. Equations 2-14 and 2-15 are iteratively applied until two successive calculations of each 

temperature are sufficiently close. 
. 

- 2.3- GAS CIRCULATION 

The method for computing temperatures in the rock formation with gas circulation is the same as 

that discussed in the previous section for fluid circulation. The fluid properties of gas are used in these 

calculations, including density, specific heat capacity, and convection coefficient. Equations 2-14 and 

2-15 are still valid for gas circulation. 

2.3.1 Flow Variables 

The flow of gas is described by three conservation laws of fluid mechanics: balance of 

mass, momentum, and energy. 

Figure 2-5 illustrates the flow of gas in a constant area duct with cross-sectional area A and 

length Az. 
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7 
Figure 2-5. Constant Area Flow Cell 

- 
~ - ~- 

=- -.- 
- .. .. , .. The mass flux density G is defined by 

-- I t i s  easy to prove that G is constant for constant-area ducts due to the balance of mass. - - 
Balance of momentum is expressed in the following form: 

where 

D is the hydraulic diameter, and f is the Darcy friction factor. 

An additional relation needed to solve Eq. 2-17 is the equation of state for an ideal gas 

where R is the ideal gas constant. If the temperature is known, Eq. 2-17 is reduced to a nonlinear 

integral equation for the velocity. When velocity has been determined, the remaining flow variables can - 
be determined. 

-. Assuming a linear velocity and employing the method of residuals, Eq. 2-17 can be solved - 
approximately for the exit velocity v,: 
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where 

c = GRT, 

Equation 2-19 does not have a real solution for negative values of the determinant b2-4ac. 

- Thephysical sense of a negative determinant is that the flow has choked, i.e., there is not enough -~ - 

pressure to support the assumed mass flow rate. Either the inlet pressure needs to be increased or the 
~ ~ ~ ~ ? . -  
-.XbW. rate decreased until the determinant is positive. 

~ ~ 

~~ 

~~ ~ 

- - 2.3.2 Air and Nitrow Pro~erties 

- ~ In GTEMP1, air and nitrogen are modeled as ideal gases. The properties are listed in 
~- 

- 1  .---.Table 2-2. 

- -  ~ - TABLE 2-2. Gas Properties 

The thermal conductivity is defined by the following relationship 

k = C P ~ / P r  

where C, is the specific heat capacity, and the Prandtl number Pr is 

where y is the ratio of specific heat for both air and nitrogen. 
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Viscosities are determined by the following correlation (Zucrow and Hoffmure, 1976) 

- where the coefficients are listed in Table 2-3. 

TABLE 2-3. Coefficient A, 

- 
2.4 TWO-PHASE STEAM PRODUCTION AND INJECTION 

- - 2.4.1 Flow P a t t a  

Vertical two-phase steam flow is categorized by the regimes of flow geometry and velocity. 

- There are four generally accepted categories of two-phase steam flow: bubble, slug, transition, and 
rC 

annular-mist (Figure 2-6). 
- - 1. Bubble Flow 

The pipe is almost completely filled with liquid; the gas volume is small. Gas is 

distributed as small, randomly-sized bubbles that rise at velocities dependent on their 

size. The gas phase has little effect on the frictional pressure drop caused by the liquid 

velocity. 

2. Slug Flow 

Gas bubbles coalesce to form larger, cap-shaped bubbles nearly spanning the pipe. 

Bubble velocity is greater than liquid velocity. Both gas and liquid phases have a 

significant effect on pressure drop. 

3. Transition Flow 

A transition from continuous liquid phase to continuous gas phase occurs. Although 

liquid effects are important, the gas phase dominates behavior. 

4. Annular-Mist Flow 

The gas phase is completely dominant and the liquid phase is carried as droplets. 
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FLOW DIRECTION I 7  

Superficial Gas Velocity, VSG, f I . /  sec. 

Figure 2-6. Vertical Flow Patterns of Two-Phase Steam (Govier et al., 1961) 
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Modeling temperature in a two-phase steam flow is performed as follows. For inlet - 
conditions to a flow element, the flow regime is identified. Appropriate correlations are then used to 

determine frictional and gravitational pressure drops across the element. Exit pressure is determined and 

saturated temperature is then determined from thermodynamic correlations. The energy equation is then 

solved to determine the phase change in the flow element. For single component calculations, pressure 

and temperature are independent variables, and momentum and energy equations are solved 

simultaneously, as in previous sections. 

2.4.2 Determination of Flow Regime 

Flow regime limits are defined by the following dimensionless numbers: 

where 
- 

(L), = 1.071 - 0 . 2 2 1 8 v i / ~  [(L), 2 0.131 

(L)s = 50 + 36vgDvsw/vsg 

(L), = 75 + 84 ( vgDvSwvSg 

v, = Q,/A, = gas average velocity 

v, = Q,/& = liquid average velocity 

- v,, = Q,/A = superficial gas velocity 

v,, = Q,/A = superficial liquid velocity 

V, = v,, + v,, = average velocity of two-phase mixture 

v, = bubble rising velocity 

vgD = ~ , ~ ( p ~ / g u ) ~ ~ ~  = gas velocity number 

A = cross-section area 

A, = area fraction of gas 

A, = area fraction of water 

Q, = gas volume flow rate 

Q, = water volume flow rate 

p, = density of water 

a = surface tension 
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Limits for various flow regimes are defined in the following way: 

Bubble flow: v,%/v,, < (LIB 

Slug flow: vsglvm < &)B 

vso <(Us  
Transition flow: (L), > vSD > (L), 

Mist flow: V s ~  > (L)M 

2.4.3 Pressure D r o ~  Correlations for Two-Phase Flow 

The basic equation used to predict pressure drop is the conservation of momentum for the 

mixture of two-phase steam: 

where - - 

p, = density of the mixture 

t, = frictional pressure drop of the mixture 

The terms p, and r, are defined by correlations for each flow regime (Orkiszowski, 1968). 

2.4.4 Phase Changes 

Balance of energy provides the equation for determining phase changes. The energy 

equation for a two-phase mixture of gas and water has the following form: 

where h is the specific enthalpy, q is the heat flux per unit length of pipe, and A denotes the change in 

properties from inlet to exit of a flow element. 
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The thermodynamic region where liquid water and vapor coexist is called the two-phase 

region, and states of liquid and vapor are called saturated-liquid and saturated-vapor states. Gibb's law 
I of equilibrium requires that pressure and temperature cannot be independent variables in the two-phase 

region. The saturated temperature T, is given by the following equation: 

- 
where 

- - the-critical temperature T, = 647.19 OK; and the critical pressure p, = 220.88 bars. 

- ; ..~- . - - SURFACE MUD TANK 

The circulated fluid returns to the surface mud tank and will be mixed with the fluid in the tank. 

The temperature of this mixed fluid may be calculated by considering the balance of energy as follows: - 
h 

where ~ - 

mixed fluid temperature 

fluid temperature in the tank 

fluid volume flow rate 

volume flow rate of secondary flow (influx) 

circulation fluid density 

secondary fluid density 

circulation fluid specific heat capacity 

secondary fluid specific heat capacity 

circulation time increment 

exit temperature of fluid 

surface tank fluid volume 
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Note that the fluid temperature in the tank is different from the environmental temperature, and 

that heat transfer will occur between the tank and its environment. The final fluid temperature (T) of 

the mixed fluid in the tank may be approximately predicted by the following equation (Sucec, 1985). 

T = T, + (T - T,) e (2-30) 

where 

T , = environmental temperature 

a = combrehensive heat transfer coefficient 

__~__ _ A, . . , + - ~ >  - == = 

= fluid surface area of the tank. 
.- ~ - 

01997 Maurer Engineering Inc. 



- 
3. Input Data Files 

There are five data files associated with the input for GTEMP1: well data file (WDI), survey data 

file (SDI), tubular data file (TDI), parameter data file (PDI), and project file with the extension name 

(.GTE) containing the paths and filenames of all four files. 

3.1 WELL DATA FILE - WDI 

The WDI file stores the well name and identification and is for reference only. The user can run 

the program without the WDI file. The extension for the WDI file is ".WDI." 

3.2 SURVEY DATA FILE - SDI 

The survey data file consists of a sequence of measured depths, each with an associated inclination 

angle and azimuth angle. These values can be input into the program individually or imported from a 

- WELPATH5 ( D E A 4  program) generated survey. The extension for the SDI file is ".SDI." The SDI 
file must be in ASCII format, and the structural format of the file is: 

Number is the number of measuring stations. 

lnclinhation Unit Indicator is either D or M: 

"D" signifies that inclination readings were entered in decimal degrees. Example: 
29.50. 

"M" signifies that inclination readings were entered in degrees and minutes. Example: 
29:30. 

Azimuth Unit Indicator is either A or 0: 

"A" signifies that the azimuth readings were entered in angular format. Example: 
150. 

"0" signifies that the azimuth readings were entered in oil-field format. Example: S30E. 

The measured depth in the first survey station must be 0; therefore, the data file must start at the 

surface. - 
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Data in the SDI files are stored on disk in the angular and decimal degree format. Inclination and 

azimuth angle unit indicators instruct the program to display or accept the data in a certain format. 

A maximum of 400 survey stations can be accommodated by the program. 

3.3 TUBULAR DATA FILE - TDI 

Table 3-1 displays required tubular data for GTEMP1. 

TABLE 3-1. Tubular Data Table (Required) 

ID 
OD 
B O ~ O M  OF TUBING INTERVAL 
LENGTH OF CEMENT OUTSIDE TUBING 

Table 3-2 displays additional tubular data that have been given default values. 

TABLE 3-2. Tubular Data Table (Default) 

In most cases, default values can be used in the calculation. These values may be modified, if 

necessary. 
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3.4 PARAMETER DATA FILE - PDI 

The parameter data file serves two major functions: 1) describes the flowing stream in the 

wellbore, and 2) specifies the time interval when flowing stream data are to be used. As many as twenty 

operation schedule changes can be stacked to describe the flowing history of a well. The parameter data 

are summarized in Table 3-3. 

TABLE 3-3. Parameter Data Table 

SECONDARY FLOW IDENTIFICATION (Y/N) 
FLUID IDENTIFICATION NUMBER (OR GAS TYPE) 
FLUID INLET TEMPERATWE 
FLUID VOLUME FLOW RATE 
FLOW PERIOD END 

SECONDARY FLOW FLUID IDENTIFICATION NUMBER 
INLET TEMPERATURE 
VOLUME FLOW RATE 

I 

GAS PROPERTIES STANDPPE PRESSURE 

INITIAL FLUID FLUID IDENTIFICATION NUMBER IN TUBING & ANNULUS 
PACKER FLUID IDENTIFICATION NUMBER 

STEAM PROPERTIES STEAM IDENTIFICATION NUMBER (011) 
STEAM QUALITY (0) OR INLET PRESSURE (1) 

FLUID PROPERTIES FLUID IDENTIFICATION NUMBER 
DENSITY 
PLASTIC VISCOSITY (BINGHAM FLUID) 

OR YIELD POINT (BINGHAM FLUID) 
CONSISTENCY COEFFICIENT (POWER-LAW FLUID) 
EXPONENT OF POWER LAW (POWER-LAW FLUID) 

FLUID IDENTIFICATION NUMBER 
DENSITY 
VISCOMETER READING AT R = 600 REV/MIN 
VISCOMETER READING AT R = 300 REV/MIN 

VISCOMETER READING AT R = 200 REV/MIN 
VISCOMETER READING AT R = 100 REV/MIN 
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3.5 PROJECT FILE - GTE 

The project file documents the set of files and settings used for a specific case. The project file 

contains the path and filenames of well, survey, tubular, and parameter data. It also contains the 

operational option selections. 

Files that make up a project do not have to be in one directory of the hard drive, because the 

project file documents the file locations. In addition, a single file, such as the survey data file, can be 

part of more than one project. 
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4. Program Installation 

- 
4.1 BEFORE INSTALLING 

4.1.1 Check the Hardware and Svstem Reauirement~ - 
GTEMPl is written in Visual Basicm. It runs in either the standard or enhanced mode 

of Microsoft Windows 3.0 or higher. The basic requirements are: - 
Any IBM-compatible machine built on the 80286 processor or higher 

- Hard disk 

. - Mouse 

- CGA, EGA, VGA, 8514, Hercules, or compatible display (EGA or higher resolution 
is recommended) 

-- - 

MS-DOS version 3.1 or higher - 
Windows version 3.0 or higher in standard or enhanced mode 

- - A 486 (or higher) IBM compatible PC and Windows 3.1 (or higher) are highly 

recommended for fast performance. 

- For assistance with the installation or use of GTEMPl contact: 

! 

/ Xichang ZhanglGefei LiuILee ChulRuaselI W. H a ,  J r .  
i MAURER ENGINEERING MC. 

2916 West T.C. Jester Boulevard 
Houston, Texas 77018-7098 U.S.A. I 

1 TeIephone: 7131683-8227 Fax: 7131683-6418 

j Internet: http:Ilwww.maureng.com 
j EMail: m e i d  maureng.com 

4.1.2 Check the - 
The program disk received is one 3 %-in. 1.44 MB disk. The disk contains sixty-eight 

files. These are executable files, example data files of GTEMPl and other library files used by the - application. 
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MDICHILD.VBX SETGTE.EXE GTEMPI .EX- SETUP.LST 
GSW.EXE GSWDLL.DLL 

COMMDLG.DLL SETUP.EXE SETUPKIT.DLL 
WTTEST1 .GT1 WTTESTl.GP1 

WTTEST1. SDI WTTEST2.GTl WTTEST2.GPl 
WTTEST2.SDI WTTEST3. GT1 WTTEST3. GP1 
WTTEST3.SDI WTTEST4.GTl WTTEST4.GPl 
WTTEST4.SDI WTTEST5.GTl WTTEST5.GPl 
WTTESTS.SD1 WTTEST6.GTl WTTEST6.GPl 
WTTEST6.SDI WTTEST7.GTl WTTEST7.GPl 
WTTEST7.SDI WTTESTS.GT1 WTTESTS.GP1 
WTTEST8.SDI WTTEST9.GTl WTTEST9.GPl 

WTTESTlO.GT1 WTTEST1O.GPI 
TUBING.DBS WTTESTlO.SD1 

To avoid conflict with other library versions, we recommend that all .VBX and .DLL files 

be installed in the same sub-directory as the GTEMPl executable (GTEMP1.EXE) and example data 

files. All these procedures are accomplished by a simple set-up command explained in Section 4.2. 
- - -  

To run, the user must install all the files into the appropriate directory on the hard disk. 
- 

Please see Section 4.2 to set up GTEMPl. 

4.1.3 Backuu Disks 

It is advisable to make several backup copies of the program disk and place them in 

different storage locations. This minimizes the probability of all disks developing operational problems 

at the same time. 

The user can use the COPY and DISKCOPY command in DOS, or the "Copy Disk ..." 
command in the Disk menu in the File Manager in Windows. 

4.2 INSTALLING GTEMPl 

4.2.1 Automatic Installation 

The following procedures install GTEMPl from the floppy drive onto working sub- 

directories of the hard disk (i.e., copy from A: drive onto C: drive sub-directory GTEMPl). 

1. Start Windows by typing "WIN" <ENTER> at the DOS prompt. 

2. Insert the disk. 

3 .  In the File Manager of Windows, choose Run from the Eile menu. Type a:setup and 

press <Enter > . 

4. Follow the on-screen instructions. 
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After successful set up of GTEMPl, there is a "DEA Application Group" that contains - GTEMPl application icon, as shown in Figure 4-1. 

FoanlO Rmadl Re& H,&wz T1w1 Wekm2 

' & Q m  
Web& HOTWLL D D M 8  -4 CTUFEl CDU4G3 

@ i ! i J ~ ~ ~ ~  
H O E  DRlFEl L D M 4 O  GRPlDMODl GTEMPl 

- 

Figure 4-1. "DEA Application Group" Window Created by Setup 

4.2.2 Manual Installzltinn 
Follow these steps to manually install the program should automatic installation fail: 

1. Create a sub-directory on drive C: C:\GTEMPI 

2. Copy all files on the disk into C:\GTEMPl 

3. The file extension with the third character underscored is the compressed file. To 
expand these files, the user can type the following commands in the DOS environment. 

EXPAND VER. DL- VER.DLL 

EXPAND GTEMPI .EX - GTEMP1 .EXE 

4. Type: CD.. <Enter> then key in "WIN" <Enter> to start Windows 3.0 or a later 
version. 

5. Select "New.. ." from File under "Program Manager" Window. In the "New Program 
Object" dialog box that follows, select the Program Group option, then click on the 
<OK > button. 

6. In the "Program Group Properties" dialog box, key in "DEA Application Group" after 
label "Description," and key in "DEAMEI" after "Group File," then click on <OK> 
button. A Group Window with the caption "DEA Application Group" appears. 

7. Select "New ..." from File under "Program Manager" Window. In the "New Program 
Object" dialog box that follows, select the Program Item option, then click on the 
<OK > button. 
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8. In the "Program Item Properties" dialog box, key in "GTEMP1" after label 
"Description." Key in "C:\GTEMPl\GTEMPl.EXE" after label "Command Line." 
Click on the <OK > button. The GTEMPl icon appears inside the "DEA Application 
Group" Window. 

4.3 STARTING GTEMPl 

4.3.1 Starting GTEMPl from Group Window 

To run GTEMPl from the Group Window, simply double-click the GTEMPl icon, or 

when the icon is focused, press <ENTER>. 

4.3.2 Usine Command-Line Option from Windows 

In the Program Manager, choose Bun from the File menu. Then type 

C:\GTEMPl\GTEMPl .EXE <ENTER> as shown in Figure 4-2. 
- - - 

- 

r- 13 Run 1 
Eonnand Line: 

C:\GTEMP~\GTEMPI.EXE 

Run Mnimhed 

Figure 4-2. Using Command Line to Start 
GTEMPl 
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5. Windows Environment 

GTEMPl runs in the Windows environment. For comprehensive information about Windows, see 

Concise Guide to Microsoji Windows 3.1 by Kris Jarnsa (Microsoft Press, 1992) or other books on 

Microsoft Windows. This section presents only a brief description of the Windows environment. 

5.1 TYPICAL WINDOWS 
- Consider the parts of a typical window. Figure 5-1 shows the Program Manager Window with 

various components. 

. . 
. .  --7 . 

Contml Box T i k  -Box 1 

- Rognm Manager ]-I:[ 
File Qptionr W n d w  Help - 

@ ! a @  
B&IO -1 W t b d  D*-7 

~~m 
esma1 s k p l h  B h b d  bnd U43 u.93 

4 
pJ 
G 1 * s  

I : : : I m m m m r n  
V ~ B -  urn SWD U d  PLSPW B & G R P Y & & W  

10 ome 

Figure 5-1. Program Manager Window 

1. Title Bar 

The title bar serves two functions: to display the name of the current window and to indicate 
which window is active. The active window is the one in which the title bar is in color. (On 
monochrome monitors, the difference is shown by the intensity of the title bar). The user can 
make a window active by clicking anywhere within its border. 

2. Control Boxes 

At the left of the title bar is the control box. It has two functions: 1) it displays the 
CONTROL menu, which enables the user to control the window size using the keyboard and 
2) double-clicking the control box ends the current program. 
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During execution of GTEMP1, the control boxes are not needed. The program runs according 
to its own flow chart. 

3. Minimize and Maximize Boxes 

At the right of the title bar are the MINIMIZE and MAXIMIZE boxes. The box with the up 
arrow is the MAXIMIZE box. The box with the down arrow is the MINIMIZE box. If a 
window has been maximized, the MAXIMIZE box changes to a RESTORE box with both up 
and down arrows, as shown in Figure 5-1. 

Clicking on the MINIMIZE box reduces the window to an icon. The window's name in 
the title bar appears below the icon. To restore a window from an icon, double-click on 
the icon. 

Clicking on the MAXIMIZE box enlarges the window to fill the total working area. 

- - 
Clicking on the RESTORE box, sizes the window so that it fills only a portion of the total 
working area, which is determined by how the user manually sizes the window. 

The user should avoid clicking these boxes while running GTEMPI unless necessary. 

4. Icons 

Windows makes use of icons extensively. Icons are small graphic symbols that represent 

specific applications. Icons are identified by their appearance, as well as an accompanying 

label. Usually, the user can start an application by double-clicking its icon. 

5.2 DIALOG BOXES 

In the dialog box of a normal window, the user will find one or more of the following elements. 

1. Text Box 

TEXT boxes display information that the user enters. Sometimes there is text already typed 
in for the user. The arrow keys can be used to edit the existing text. Figure 5-2 shows a 
typical text box. 

Command Line: - 
C:\GTEMPl\GTEMPl .EXE 

Figure 5-2. Text Box 

2. Option Button 

An OPTION button is an exclusive setting. Selecting an option immediately causes all other 
buttons in the group to be cleared. Figure 5-3 is a typical option box. 
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I I 

Figure 5-3. 
Option Buttons 

3. Command Button 

A COMMAND button performs a task when the user chooses it, either by clicking the button 
or pressing a key. The most common command buttons are the OK and Cancel buttons found 
in almost every dialog box. In most cases, there is a button with a thick border-the default 
button, which is executed if your press <ENTER > . Figure 5-4 shows a typical command 
button. 

- --- 

Figure 5-4. Command Button 

- - 4. Lit Boxes 

A LIST box gives the user a list of options or items from which to choose. If the LIST box 
- is too small to show all possible options, a SCROLL box appears on the right side of the box. 

From the LIST box, the user can make a selection by clicking on it, or from the keyboard, by 
highlighting the desired item with the arrow keys, and then pressing < ENTER > . Figure 5-5 - is a typical list box. 

Figure 5-5. List Box 

5. Drop-Down Lit Boxes 

A DROP-DOWN LIST box is indicated by a small arrow in a box to the right of the option. 
The current setting is shown to the left of the arrow. When the user clicks on the small arrow, 
the box expands to list all selections. A typical drop-down list box is shown in Figure 5-6. 
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Figure 5-6. 
Drop-Down List Box 

6. Scroll Bars 

SCROLL BARS are graphical tools for quickly navigating through a long list of items. There 
are two types of scroll bars: HORIZONTAL and VERTICAL SCROLL BARS. 

The small box inside the bar is called the SCROLL BOX. The two arrows at the end of the 
scroll bar are scroll buttons (Figure 5-7). Clicking the scroll buttons or moving the SCROLL 
BOX changes the portion of information being viewed. 

Figure 5-7. Scroll Bar 

7. Grid 

GRIDS display a series of rows and columns (Figure 5-8). In case of a long list of items, or 
a large amount of information, scroll bars attach to the grid providing easy navigation. 

Figure 5-8. Grid 

I.D. 
[in1 

8.68 
12.35 
13.12 

29 

In the data input window, grids are used to assist with data entry. Some columns of the grid 
only allow numeric input. Typing an alphabetical character is not allowed by the program. 
The user can edit an entry by typing desired characters or pressing the <BACKSPACE > key 
to delete. In many grids, just like a spreadsheet, the user can insert or delete rows. 

Note: In the Output Window, grids are for presentation only. They do not allow editing. 

0.0. 
Iinl 

3.63 
13.38 

20 
30 

The grid supports word-wrapped text presentations, resizeable columns and rows, etc. Even 
though the user can manually change column widths or row heights of a cell, it is not 
recommended because all grids in GTEMPI are carefully designed to fit the length of the 
appropriate data string. 

Casing Set Depth 
Iftl  

5000 
3000 
1000 
100 
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6. Basic Operation of GTEMPl 

- 
GTEMPl operates in a Windows environment. Windows graphics user interface (GUI) and point- 

andclick environment give the power and flexibility needed in this application. In this chapter, basic - operation and functions of GTEMPl are described. 

- 6.1 WINDOWS IN GTEMPl 

There are three principal types of windows in GTEMPl: Introductory, Input, and Output 

- Windows. The flow diagram of GTEMPl Windows is shown in Figure 6-1. 

Introducton, Window A 

Output Window 

Figure 6-1. Flow Diagram of GTEMPl 
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6.1.1 Introductorv Window 

Figure 6-2 shows the Introductory Window containing basic information on the program 

and the disclaimer. 

- Maurer Engineering Inc. 

Wellbore Thermal Simulation Model IGTEMP 1.01 

DEA-67 
Project to Develop and Evaluate Coiled-Tubing and 

Slim-Hole Technology 

By  
Maurer Eng~neerlng Inc  

Thls copyrlghled 1996 confidential report and computer program are forthe sole 
use of Partldpants on the Drllllng Engineerlng Assodatlon DEA-67 proled and 
their affillales, and are not to be disclosed to other parties. Data oulput from the 
program can be disclosed to third parties. Participants and their afflllates are free 
to make copies of this report and program for their in-house use only. 

Maurcr Englnccring Inc. makes no warranty or representation. elther expressed 
or Impllcd, with resped to the program or documentatlon. lncludlng thclr quality, 
pcrlormance. memhantabllity. or fitness for a particular purpose. 

International keyboard users should read AppcndixA of User's Manual 

Figure 6-2. Introductory Window 

There are two command buttons, " O K  and "Exit." Clicking "Exit" terminates the program. 

The "OK" button is the default command that means the user can press the button by pressing 

<ENTER > or clicking on the button. This invokes and displays the Project Window. 

6.1.2 I n ~ u t  Window 

The Input Window consists of five windows for input data of different categories. They 

are.: Project, Well Data Input, Survey Data Input, Tubular Data Input, and Parameter Data Input 

Windows. 
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6.1.2.1 Project Window 

Figure 6-3 shows the Project Window of GTEMPl. 

F a u d  C i W i  @ 6 . 1  F m d  t iWm 

: O L l a a l r i c b l n  C 9,- l l i c l i l  

F h N l r l G I E )  f \E lEYFl \WTESTl .G lE  

W d D a l a F L W I )  W l f S l l . W I  

s-Da.m ISDI) w r f s r i  SDI 

I-DM.FLPII) W r E s r i  611 

Ur* E d  

Figure 6-3. Project Window 

The Project Window consists of four segments: 

1. Operational options available. 

2. Path and name of each data input file. 

3. System of units currently in use. 

4. Calculating progress indicator. 

The project file for GTEMPl has the extension "GTE." 

6.1.2.2 Well Data InDut 
Figure 6-4 shows a typical Well Data Input Window. 

Well Data Input W l n d o v  

v , q r ( u -  JGIEUPI (I 

vd N- lau i r l n c r a  -9 

0.I. -10  1335 

C-. L 9 d R O d Y l i  

Figure 6-4. Well Data Input Window 
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The user is asked to input a series of strings representing the company name, project 

name, well location, date, and comments. These are optional and need not be completed. They are not 

used in calculations or in file name specifications. 

Well data files for GTEMPl have the extension "WDI." 

6.1.2.3 Survey Data Input 

Figure 6-5 shows a typical Survey Data Input Window. 

Figure 6-5. Survey Data Input Window 

The user can input up to 400 survey data points. Measured depth, inclination and 

azimuth angles each have two unit options independent of the selected application system of units. 

When the cursor is in the text box, press the - or - key to move the cursor inside 

the box to edit. Pressing the r or 1 key moves the cursor to the box above or below. If the user wants 

to move the cursor to the right or left box, hold down the Ctrl key and press - or -. Of course, the user 

can use the mouse or press the tab key to locate the cursor. 

SDI files used in GTEMPl are compatible with any SDI files for other DEA 

software applications developed by Maurer Engineering Inc. 

The survey data file for GTEMPl has the extension "SDI." 
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6.1.2.4 Tubular Data Input 

Figure 6-6 shows a typical Tubular Data Input Window. 

Figure 6-6. Tubular Data Input Window 

- - 

Note that tubing input is from the surface to the bottom of the hole, and casing input 

is from the smallest to the largest casing (from inside to outside). Initial depth of the well must be - P shorter than or equal to the total measured depth in the survey data file. Wellbore diameter must be 

greater than the largest casing OD. 

- The user can change the units for data input by using the [Unit Change] command 

button after clicking the corresponding grid (see Section 6.3.7 for details). The [Help] button in the 

- geothermal temperature grid provides basic information on geothermal temperatures and their gradients 

in several regions (Figure 6-7). 

I I 5 0  -- 
0 ODD ,000 n m  a000 l o r n  12000 (n, I I 

oepm (RI 

n u l e ~ d ~ ( T k r p l ~ k = h a U r ~ r I 1 1 I 1 b i a m ~ d 1 k ~ l  

Figure 6-7. Geothermal Temperatures and Gradients 
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The user can use the [Default Parameter] command button to change the default 

parameters if any modification is desired. Figure 6-8 shows the Default Tubular Data Window. 

Figure 6-8. Default Tubular Data Window 
- - - 

The user can modify the thermal properties of tubing and casing, as well as rock. 

The user can also specify the grid used in the calculation. To assist the user in the selection of thermal 

properties, GTEMPl has two database tables of commonly encountered materials (Figures 6-9 and 6-10). 

The user can edit these tables by using the "Add" and "Delete" command buttons, or copy the desired 

material parameters to the Default Tubular Data Window by selecting the material and clicking the [Copy 

to TDI.. .] command button. The [Reset] command button is used to set these parameters back to the 

default values. Note that the user must modify the rock properties for a multi-layer rock formation. 

- U.lcdal Repc ly  T&le 
glc 

1 Tublng and Caslng Thermal Ropert~es 

Figure 6-9. Tubing and Casing Thermal Properties 
Table 
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I Rock Thermal Properties I 

I 

Figure 6-10. Rock Thermal Properties 

The tubular data file for GTEMPl has the extension "GT1." - 
Figure 6-1 1 shows a typical Parameter Data Input Window. 

Figure 6-1 1. Parameter Data Input Window 

The user can change the input units by using the [Unit Change] command button 

after clicking the corresponding grid. Note that fluid viscosity must be the value at 70°F. 

The parameter data file for GTEMPl has the extension "GP1." 
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6.1.3 Output Window 

After all data are input, click the start command from the Bun menu in the Project Window 

to begin calculating. The calculating percentage complete indicator at the bottom of the screen shows 

the percentage of calculation completed. 

When the calculation is complete, the program unloads the Project Window and shows the 

Output Window with four "child" windows arranged in a tiled format. "Child" windows are employed 

to display text reports and graphs of output. A "child" window is a window confined to its "parent" 

window - the Output Window. "Child" windows can be displayed independently by selecting the 

corresponding menu item in the windows menu of the Output Window. The user can manipulate them 

as normal windows - move, resize, close, etc. The arrangement commands in the windows menu 

(Cascade, Tile, Arrange Icons) have the same functions as those in the Program Manager of Windows. 
" - " . 

Figure 6-12 shows the Output Window with the four "child1' windows tiled inside. 

Re.+." 
O p l i a  [F*d D.ptl 

1.0 3.3 15.' 

0 118.6 m.0 m - 1 
200 1~1.0 112.9 a. 
400 126.0 115.2 a. A5 

' 
Start Time 

Figure 6-12. Output "Child" Windows 
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6.1.3.1 Thermal Analvsis 

Figure 6-13 shows a typical Thermal Analysis Window. 

Figure 6-13. Thermal Analysis Window 

- The graph in the left portion of the window shows the wellbore configuration. This 

figure also shows temperature distribution, with different colors in the tubing for production and 

- 
h 

injection or in both the tubing and annulus for circulation. By positioning the mouse at an interesting 

point on the wellbore configuration graph and clicking it, the user can obtain temperature distributions 

in both the radial and axial directions, as indicated by the intersecting lines. The user may also select - 
the tubing or annulus option buttons if temperature distributions in the tubing or annulus are desired. 

These temperature distributions are printed in two grids and plotted in two graphs in this window. The - user can enlarge or reduce any of these graphs by double-clicking them. Figures 6-14, 6-15, and 6-16 

show these enlarged graphs. 

Figure 6-14. Wellbore Configuration 
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Figure 6-15. Temperature Distribution in Radial 
Direction 

Figure 6-16. Temperature Distribution in Axial Direction 

To print out the grids or graphs, refer to Section 6.2.2. 

6.1.3.2 Three-D- Temperature Distribution 

Figure 6-17 shows a typical Three-Dimensional Temperature Distribution window. 
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In the right portion of the window is a three-dimensional view of temperature - - distribution. In the left portion of the window is the temperature distribution grid displaying 

temperatures at different radii and measured depths. By changing rotation and overview angles using 

- the scroll bars or typing in the text box and clicking the [Redraw] command button, the user can view 

the three-dimensional temperature distribution from different angles. By double-clicking grid or graph, 

the user can enlarge or reduce those portions of the screen. 

Figures 6-18 and 6-19 show the enlarged grid and graph. 

Figure 6-18. Three-Dimensional Temperature Distribution 
Table 
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0 
31) Tempenhy. Dhibotion at mar Time 10(day) II J! 

Figure 6-19. Three-Dimensional Temperature Distribu- 
tion Graph 

6.1.3.3 Tem~erature and Pressure in Tubin? and Annulus 

Figure 6-20 shows a typical Temperature and Pressure in Tubing and Annulus 

Window. Note, for operations with gas and steam, both temperature and pressure are plotted. For 

- , . . operations . . .. with liquid, only temperature is plotted. 

Figure 6-20. Temperature and Pressure in Tubing and 
Annulus Window 

In the right portion of the window is the temperature distribution graph (and 

pressure distribution graph, if gas or steam is used in the operation). To show temperature distributions 

in the tubing, annulus, or tubing and annulus together with the undisturbed geothermal temperature 

distribution, the user can select one of the following options: 
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1. Tubing 

2. Annulus 

3. Tubing and Annulus 

There are three command buttons in this window: 

1. "Select" - selects a flow period by clicking the desired flow period and the 
[Select] command button 

2. "Remove" - removes a flow period by clicking the desired flow period and 
the [Remove] command button 

3. "Redraw" - updates the graph in the right portion of the window after the 
"Select" or "Remove" command has been executed 

* F 
The user can select and plot one or more flow periods listed in the "Flow Period" 

- frahe. The user can enlarge or reduce the graph by doubleclicking it. Figure 6-21 shows the enlarged 
- 

graph. 

Figure 6-21. Temperature in Tubing and Annulus 

6.1.3.4 TemDerature i n T u h g  
Figure 6-22 shows a typical Temperature and Pressure in Tubing Window-1. 
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Figure 6-22. Temperature and Pressure in Tubing 
Window-1 

Note that for operations with gas and steam, both temperature and pressure in the 

tubing are output; for operations with liquid only, temperature in the tubing is output. 
- 

The user can specify the position in the tubing and time period by typing these 

numbers in the "Fixed Depth," "Start Time," and "End Time" text boxes. When finished, click the [OK] 

command button to calculate temperature and pressure profiles and display the results in the Temperature 

and Pressure in Tubing Window-2 (Figure 6-23). 

1.38 9 6 6  
1.97 1DC.O 
2-70 103.4 
1.62 106.8 
4 .  110.3 
6.19 113.7 
7.38 1170 

i o n  1m.2  

1690 I E . 2  
m m  1 n . o  
2 6 P  IZB.2 
3115 1 8 . 0  
41.67 1 8 . 4  
5233 1 8 . 7  
6 ~ 6 5  1m.o 
B Z 3 l  111.2 

103.12 i m . 4  

Figure 6-23. Temperature and Pressure in Tubing 
Window-2 
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- In the left portion of the window is the grid showing the temperature at different 

times. In the right portion is a graph showing temperature versus time at a fixed depth in the tubing. 

The user can enlarge or reduce the graph by double-clicking it. Figure 6-24 shows the enlarged graph. 

Figure 6-24. Temperature Versus Time in the Tubing - 

r ~ 4  Note that the user may calculate and display the temperature and pressure profiles 

at other tubing positions or time periods by selecting "New Profiles ..." from the File menu of this 

window. 

6.1.3.5 

Figure 6-25 shows a typical Undisturbed Geothermal Temperature Window. 

- Undisturbed Geothermal Temperature 

Rock Formmon ~ ~ " d  ~ r e r ~ l  
& 

Figure 6-25.Undisturbed Geothermal Temperature Window 

6-15 01997 Maurer Engineering Inc. 



This window will be displayed by selecting "Undisturbed Geothermal Temperature" 

from the Window menu. In the left portion of the window is a rock formation schematic showing the 

materials and their thermal conductivity. In the right portion is the undisturbed geothermal temperature 

profile. 

6.2 GTEMPl MENUS 

The GTEMPl menu system provides many convenient tools for running the application. As in 

other Windows applications, the user can pull down a menu by clicking the menu name with the mouse, 

or by pressing the ALT key on the keyboard and then striking the first letter or the underscored letter 

of the menu name. Once a menu is displayed, a command can be selected by clicking the command 

name with the mouse or by highlighting the command name and pressing <ENTER > . 
4- -"- - -- 6.2.1 Menus in -put Windows 

The Input Windows of GTEMPl include five individual windows: one Project Window 

ur Data Input Windows. The menus in these windows are described in this section. 

6.2.1.1 m d o w  

There are six menus in this window: 1) File, 2) Input, 3) Bun, 4) Qutput, 

5) Utility, and 6) Help (Figure 6-26). 

I I 

Figure 6-26. Project Window Menus 

The File menu contains commands for creating, retrieving, saving, and printing 

project data (Figure 6-27). 
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- Wellbore Thermal Simulation Model [GTEMP 1.0) 1-1: 
Ell= Input Data Run Qulput Ylilily Hclp 
New Rojea 
m e n  Prolcn.. 
Saw R o j c a  
Save RolcclAs ... 
Prlnt Wlndm ... 
pdnt ProIra ... 
Rlnt All InpulRaIa ... 
EX3 CbltX 

Figure 6-27. File Menu in the Project Window 

Project files are used for quick future retrieval of a set of previously saved input 

- data. The user can open an existing project file without opening each individual (WDI, SDI, TDI, PDI) 

f i l E  The project file, which is a collection of the paths and filenames of all input data files, greatly 

simplifies data retrieval. - h 

The eight menu items under the File menu are explained below: 

1. "New Project" command clears all input data and sets all file names to null 
string with corresponding extension. 

2. "Qpen Project ..." command opens a dialog box that enables the user to 
explore the file system for input files with the extension "GTE." See Section 
6.3.1 for a complete discussion. 

3. "Save Project" command replaces the previous version of each of the input 
data files in the project with the one modified. Note that the project file 
(.GTE) does not contain any input data. It is simply a list of all the input 
data file names in the project. This list is updated every time the user saves 
the project. 

4. "Save Project As ..." command opens a dialog box. The user specifies the 
drive, directory, and the name of the project file. See Section 6.3.2  for 
details. 

5. "Print Kindow ..." command allows the user to print out the current window. 

6 .  "Print Project ..." command allows the user to print out the information 
related to the current project, such as path and filename of each individual 
data file. 

7.  "Print All Input Qa ta..." command allows the user to print out all input data 
along with the project information. 
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8. "Exit" command terminates GTEMPl. The program prompts the user to 
save the input files, if they have not been saved. 

Files that make up a project do not have to be in one directory on your hard 

drive, since the project records the detailed path information about each input file. A single file, such 

as an SDI file, can be part of more than one project. However, if you rename or delete a file outside 

the GTEMPl application, and then run GTEMPl and try to open that file, GTEMPl displays an error 

message to warn you that a file is missing. 

The Input Data menu contains commands for opening and navigating through 

four individual Data Input Windows as displayed in Figure 6-28. 

I Wellborn Thcmal Simulation Modcl IGTEMP 1.01 -1: 
9lc lnpvt Dab Bun Qulput Mility Help 

Well Data lnput 
S u m y  D M  Input 
Iubulmr Dala lnput 
parameter Dsfm lnput 

Figure 6-28. Input Data Menu in the Project Window 

1. "&ell Data Input" command opens the Well Data Input Window. 

2. "Survey Data Input" command opens the Survey Data Input Window. 

3. "Tubular Data Input" command opens the Tubular Data Input Window. 

4. "parameter Data Input" command opens the Parameter Data Input Window. 

The Run menu (Figure 6-29) contains the command to start calculation. The 

"Start" command does just that. The program checks the validity of all data before calculation. 
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- - below: 

- W=llborc Thrrmal Simulation Modcl IGlEMP 1.01 1-1: 
Ellc !"put Oata Bun Qutpul Ytiilty Hclp 

Figure 6-29. Run Menu in the Project Window 

The Qutput menu (Figure 6-30) contains four menu items, which are described 

1. "Besults Displayn command allows the user to go to the Output Window 
without calculating, if the calculation has been completed. 

2. "New Results Display" command allows the user to display the Output 
Window without calculating, if the calculation has been completed and the 
input data have not been changed; or to display the Output Window after 
calculating, if the input data have been changed. 

3. "Save Results As ..." command allows the user to save the output results as 
a text file. The file extension name is ".OUT." 

r 1 

Figure 6-30. Qutput Menu in the Project Window 

Wcllborc Thcrnl l  Slmulatlan Model (GTEMP 1.01 1-I:l 
!"put Data Bun Q q u t  y t l l l t ~  Help 

4. "Print Results ..." command allows the user to print out the output results. 

6-19 01997 Maurer Engineering Inc. 

' 
I 

Results D l s p l y  
llw RrnvNa Oleplay 
S m  Bcrullr As... 
mnl Results... 

! 
I 

i i ~ i 
1 

1 I 

! ~ ~ 
! 



The utility menu contains commands that enable the user to select the system of 

units and unit conversion table, as shown in Figure 6-31. 

- Wellbore T h e n a l  Slnulstlon Model IGTEMP 1.0) 1-1: 
P IC Input Data Bun Qutput 1161iIy Help 

I I Eel1 Data Input I I 
S u m y  Data lnput 
Tubular Data Input I 

Figure 6-31. Utility Menu in the Project Window 

1. "English" command selects the English system of units. A check mark 
appears to the left of "English." The default system of units is "English." 

2. "SI (Metric)" command selects the Metric system of units. A check mark 
appears at the top left of "Metric." Once a system of units is selected, all 
input and output are expressed in the corresponding units. The selected 
system of units is also indicated in the Project Window, below the input data 
file names. 

3. "Unit Conversion ..." command provides the user with conversion 
information and tools for converting data from one system to another. See 
Section 6.3.6 for details. 

The Help menu gives the user information about assistance, the operational 

options, and the computer system, as shown in Figure 6-32. 
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Wallbore Thermal Slmulatlon Model [GTEMP 1.0) I - 
Input Data a 

AsSSISlance ... 
About Qpcratlons.. 
About ... 

Figure 6-32. Help Menu in the Project Window 

1. "Assistance ..." command opens the "Assistance" dialog box that displays 
MEI's address, phone number, and other pertinent information. See Section 
6.3.3 for details. 

2. "About Operation.. ." command opens the "Operation Options" Window that 
gives the user information about the available operations. See Section 6.3.5 
for details. 

3. "About.. ." command opens the "About" dialog box that gives the user instant 
reference information about GTEMPI and the current computer system 
information. See Section 6.3.4 for details. 

6.2.1.2 Individual Data lnpllt Window 

All Data Input Windows (WDI, SDI, TDI, PDI) have only one menu File. It 

contains commands for creating, retrieving, saving, and printing the corresponding data input file, as 

shown in Figure 6-33. 

Figure 6-33. File Menu in the Individual Data Input 
Window 
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1. "New File" command clears every entry box in the current data input 
window. 

2.  "Qpen File ..." command opens the dialog box that enables the user to 
explore the file system for input files with the extension names, "WDI," 
"SDI," "GT1," or "GP1" depending on the current data input window. 

3. "Save File" command replaces the previous version of the input data file. 

4. "Save File As..." command enables the user to save a file under a new name 
specified, while also retaining the original file (Section 6.3.2). The new file is 
associated with the project file when you save the project. 

5. "Print ..." command allows the user to print out the input data of the current 
Input Window. 

6. "Print Window.. ." command allows the user to print out the current window. 

7. "Return" command closes the current data input window and return to the 
Project Window. GTEMPl prompts the user to save the file if it has not 
been saved. 

Menus in the Outout Window 

The Output Window has five menus: File, Eindow, Flow Time, units, and Help (Figure 

GTEMPI .O Out ut 11 

Figure 6-34. Menus in the Output Window 

The File menu contains commands for printing text reports and graphs and controlling 

application flow (Figure 6-35). 
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- Figure 6-35. File Menu in the Output Window 

r 

1. "Zoom In.. ." command allows the user to enlarge the graphs in this window by - selecting this command and clicking on any interesting graph. 

GTEYPI.0 OU,.", 

2. "Print This Data or Graph ..." command prints out the text report or graph in this - window when the user selects this menu item and clicks the desired grid or graph. 

- - - - 
3. "Print 811 Da ta..." command prints out all the text reports in this window. 

- - 4. "Print Window ..." command allows the user to print out the current window. 

I 

- - 

5 .  "Return" command closes the Output Window and shows the Project Window. 

- 

1 

- - The Window menu contains commands that allow the user to select, activate, stack and tile 
the '!childw windows. 

ELlr M n e o r  E l a T l m e  Unbh Mrlp 
zm-m In ... 
P.,", Th,. Dm,. -8  O,.Ph ... 
P.,", Al l  D.,. ... 
P.lr.8 *lndm... 

Figure 6-36 shows the pull-down Window menu. 

Figure 6-36. Window Menu in the Output Window 

1. "~ascade"  command stacks the windows as shown in Figure 6-37. The program 
adjusts the size of each open window to occupy the same amount of display space. 
The windows are then stacked starting from the upper left corner of the Output 
Window. Only their title bars are visible. To place a window in the foreground, 
click on the window's title bar with the mouse. 
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Figure 6-37. Cascaded Windows 

2 .  "Tile JJorizontally" command tiles all the opened "child" windows 
shown in Figure 6-38. 

horizontally, as 

Figure 6-38. Horizontally Tiled Windows 

3. "Tile Vertically" command arranges the open "child" windows vertically in the Output 
Window, as shown in Figure 6-39. 
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Figure 6-39. Vertically Tiled Windows 

4. "Arrange Icons" command restores the alignment of the window icons, as shown in 
Figure 6-40. 

- GTEMPI.0 Outpul 
Ellc Mndm ElowTlme Units Help 

I 
. . .- 6 -  ti- a. a -  h-  

Tkmmd p Prarvek k l v r k  U R W . t r d  1 
W L p d  1-dm T - e 4 m d l s p a d m a d  G d b d  

R* . ,~  nllnhlm ~rrli- r r r l n h  r-*,.. 

Figure 6-40. Arranged Window Icons 

5 .  "All" command displays the first four "child" windows of the output. 

6.  "Thermal Analysis" command opens or activates the Thermal Analysis Window. 

7 .  "3B Temperature Distribution" command opens or activates the Three- 
Dimensional Temperature Distribution Window. 

8. "p and T vs. Depth at Fixed Time" command opens or activates the Temperature 
and Pressure in Tubing and Annulus Window. 
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9. "P and T vs. Time at Fixed Depth ..." command opens or activates the 
Temperature and Pressure in Tubing Window. 

10. "Undisturbed Geothermal Temperature" command opens or activates the 
Undisturbed Geothermal Temperature Window. 

The user should always minimize or close "child" windows not presently needed to 

help maintain an orderly display. 

The Elow Time menu lists all the flow periods available in the project. A check mark 

appears to the left of the currently selected flow period. 

Figure 6-41 shows the Elow Time pull-down menu. 

- GTEMPl.0 Output 1-1: 
Eile W i n d a  B m T l r n e  Units Help 

JFlow period lO[dayl 
Flow period ZOlday] 

Figure 6-41. Flow Time Menu in the Output Window 

The Units menu contains commands that enable the user to select the system of units 

and temperature unit, as shown in Figure 6-42. 
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Figure 6-42. units Menu in the Output Window 

1. "Fahrenheit (OF)" command selects Fahrenheit as the temperature unit. A check 
mark appears to its left. 

2. "Kelvin ( O K ) "  command selects Kelvin as the temperature unit. A check mark 
appears to its left. 

3. "centigrade ("C)" command selects Centigrade as the temperature unit. A check 
mark appears to its left. 

4. "Badme (OR)" command selects Rankine as the temperature unit. A check mark 
appears to its left. 

5 .  "English" command selects the English unit system. A check mark appears to 
its left. 

6. "SI (Metric)" command selects the Metric unit system. A check mark appears 
to its left. 

The Help menu in the Output Window is similar to that in the Project Window. 

6.3 GTEMPl DIALOG BOXES 

There are eight types of dialog boxes in GTEMPl: Open File, Save File As, Assistance, About, 

About Operational Options, Unit Conversion and Calculator, Unit Change, and Graph Size. 

6.3.1 " O ~ e n  File..." 
When the user selects the "Qpen Project ..." command from the Eile menu of the Project 

Window, the following dialog box appears (Figure 6-43). 
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- 
File Hame: Drectories: 

wllestl .ole c:\glempl 

List Files of lype:  Driyes: 

l ~ r o j e c t  Filesl'.GTE) I f  1 B c: ms-doi6 If 

Figure 6-43. "Open GTE File" Dialog Box 

This dialog box enables the user to search the file system for the desired files with the 
- 

extension ". GTE." 

The user can move between sections of the dialog box by simply clicking on the desired 

section. Alternatively, the user can press the <TAB > key on the keyboard until the focus moves to 

the desired section. 

There are four list boxes: drive, directory, file, and type. They are located in one text 

box-and two command buttons (OK and CANCEL). Their functions are described below. 

1. The Drive List Box 

In the lower right corner is the drop-down drive list box. In its normal state, it 

displays the current drive. When the user clicks the arrow at the right of the drive 

list box, it drops to list all valid drives. The user activates a new drive by single- 

clicking the one desired. 

2. The Directory List Box 

The directory list box displays the hierarchy of paths of the current drive. The 

current directory appears as a shaded open file folder; directions above it in the 
hierarchy appear as a nonshaded open file folder, and those immediately beneath the 

current directory are closed file folders. The user can change the directory by 

double-clicking the selected one. Note that in the directory list box, a single-click 

only selects (highlights) the item; a double-click is required for the command to be 

performed. 
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3. The File List Box 

The file list box displays the fields in the current directory. The file names shown 

are those specified by their extension name ".GTE." A single mouse click on an item 

makes it appear in the "File Name" text box. If the user chooses OK at this time, the 

data file is retrieved and all data related to the current calculation mode are displayed 

in appropriate entries. Doubleclicking the selected fde has the same effect as above. 

When the user selects a new drive, the directory list box is updated, which then 

causes the file list box contents to be updated. When a new directory is selected, the 

file list box is updated, but the drive remains the same. 

The path specification label always represents the current path information. 

4. The Type List Box 

This list box is set by the program. The user cannot change it. It specifies the type 

of files that are to be displayed in the file list box. In this "Open GTE File" dialog 

box, the type of file is "Project Files (*.GTE)." 

5. "File Name" Text Box 

When the user enters text in the "File Name" text box and then presses <ENTER > , 
this application should also do the following: 

If a drive letter is entered, the drive, directory, and file list boxes should be updated. 

If a directory path is entered (e.g., "\GTEMPln), the directory list box and the 

file list box should be updated accordingly. 

If the name of an existing file (with the extension name "GTE") is entered, the 

dialog will be completed and the files will be retrieved. 

6.  Command Buttons 

If the existing file name is shown in the text box, pressing OK completes the dialog 

and the data file is retrieved and displayed. 

If the CANCEL button is pressed, the dialog is canceled and no information is made 

available to the application. 

For example, select "C:" from the drive list box. In the directory list box, find 

"GTEMP1" under "C:\" and doubleclick it. Then the file list box should be updated 

and the file name "WTTEST1.GTE" appears in the file list box providing the user has 

set up GTEMPl using the default sub-directory names. Double-click 

"WTTEST1 .GTEn in the file list box to complete the input data file selection. 

There are four additional open dialog boxes with different extension names. They are: 
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1. "Open WDI File" for the Well Data Input Window. 

2. "Open SDI File" for the Survey Data Input Window. 

3. "Open GT1 File" for the Tubular Data Input Window. 

4. "Open GP1 File" for the Parameter Data Input Window. 

These dialog boxes are almost identical to the "Open GTE File" box in appearance; 

however, the filters in the type list box are different. Depending on the individual window, the filter 
in the type list box will be "WDI," "SDI," "GT1," or "GP1." 

6.3.2 "Save File As ..." 
When the user selects the "Savg Project As ..." command from the File in the Project 

Window, the following dialog box appears (Figure 6-44). 
- 

Figure 6-44. "Save Project As" Dialog Box 

- 

It looks similar to the "Open GTE File" dialog box; however, it allows the user to specify 

a file to save rather than open. Note that the filter in the type list box is "GTE." 

Save GTE File 

There are five file save dialog boxes with different extension names. They are: 

File baa: Qiractmiet: 

w l l m l l  .gtc c:\gtsmpl EEl 
wtleat I .gts 

V l  

S a w  File w Bpo: D i i e x  

I3 

1. "Save WDI File" for the Well Data Input Window. 

2. "Save SDI File" for the Survey Data Input Window. 

3. "Save TDI File" for the Tubular Data Input Window. 

4. "Save PDI File" for the Parameter Data Input Window. 

5 .  "Save Result as" for the Project Window. 

Depending on the individual window, the frlter in the type list box will be "WDI," "SDI," 

"GT1," "GP1," or "OUT." 
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- 
6.3.3 "Assistance.,." - 

When the user selects the "Assistance.. ." command from the Help menu in both the Project - 
and Output Windows, the following dialog box appears (Figure 6-45). 

Assistance 

I For assistance with the program, contad: I 
I Xichang Zhang Gefei Liu 

Lee Chu Russell Hall 1 
Maurer Engineering Inc. 
291 6 West T.C. Jester 
Houston. Texas 7701 8 

U.S.A. 

Tel: 171 31 683-6227 
Fax: 171 31 683-641 8 
Telex: 21 6556 

Internet: h n p : l ~ . m a u r e n g . c o m  
E-Mall: mel@maureng.com 

Figure 6-45. "Assistance" Dialog Box 

6.3.4 "About..." - - 
When the user selects the "About ..." command from the Help menu in both the Project and 

Output Windows, the following dialog box appears (Figure 6-46). - 
I 

About GTEMPl 1 
I 

Wellbore Thermal Simulation Model lGTEMP 1.01 

DEA-67 
Project to Develop and Evaluate Coiled-Tubing and 

Slim-Hole Technology 
B !  

Maurer Eng~neering Inc. 

CPU : Intel 80406 
Coprocessor : present 

Windows Mode : Enhanced Mode 
Windows Velsion : 3.1 0 

Free Memory : 17289 KB 

Figure 6-46. "About" GTEMPl Dialog Box 
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6.3.5 "About Operational O D ~ ~ O ~ S  ..." 
When the user selects the "About Operations ..." command from the Help menu or clicks the 

[Help] command button in the Project Window, the following dialog box appears (Figure 647). 

laward sircd&m r i lh  ba T h  IM a,.=,* L c  n o  sl 
Ih I u b 4 .  d IMYM w U* -h. la h su1.a. 

LIQUID REVERSE ClRCUlATlOM 
Pradcls 1 a w . h . u  lo. rmvr.. Si- dh W T h  Ihid m l r r  ho d sl 
tha .uvlra. lmd. d m  Lh a d .  rd #.(urn up h ,din. lo U* MI-. 

LlOUlD IWECTIDW 
Pr&h bmw.h.ee f a  f l d  kbdim T h  R d  &or. hc d sl Lh dm*. 
aanl. down Lh I-. rd 1b.a Wo lk vod lada dh no Ikr U* -. 

UOUID AIODUCTlOY 
Radc(* BqslA.0' k l b d  ph l ia .  T k  R.d n ( r s  Ik ral d U* bdlo.  d 
r a s t . w I k ~ l m I h d ~ a r i l h n o h i " I l a m * u  

GAS FORWARD URWLAl lOW 
 PI^. I r p r . k " u  d p.ia... 1.3, I d  win r i lh  ,,... T k  p.l d m *  
lk .al d Ik u l r a ,  bweb dorn U* b14 d rah.nt w U* -**. 

STEAM FUODUCTIDN 
Pladctr lsqalaula. rd p u u a r  la .ID.. poduslion T k  d a a  
m l a ~ U * d . ( I h ~ l ~ . d r a r a h w ~ l ~ l o U n ~ u l r . r i l h n o l l o r ~  
lh -. 

S T E M  lWECl lON 
Plcdcll1014nw,,oI rd p... UO. I. Ilo-ph... .I- inialion lk ,,nu nan 
Ik wdl al lk #amlmo. baroh d.r, U* I& rd f b r *  a. U* sock 1- r*h 
na llar i" t h  . d m .  

Figure 6-47. "About Operational Options" 

-- 6.3.6 Unit Conversion and Calculator 

- 

When the user selects the "Unit Conversion ..." command from the Utility menu, the 
following dialog box appears (Figure 6-48). 

Figure 6-48. "Unit Conversion and Calculator" 

01997 Maurer Engineering Inc. 



P 6.3.7 unit Changg 

- When the user clicks the [Unit Change] command button in both the Tubular Data Input 

and Parameter Data Input Windows, the following typical dialog box appears to allow the user to 

customize the units of a selected grid. - 

Units in Tubing Data rn 
1.0. 16.1 (1 

0.D. 

Tubing Bdtom (19 Enpli.hI 
Cement Length 1 (((1 -1 

Figure 6-49. "Unit Change" 

- 
6.3.8 11 

- 

When the user selects the printing graph command in the Output Window, the following - 
A dialog box appears to allow the user to specify graph size. 

Graph Size 

Graph Width 6.51 

Graph Height 4.43 

@ In 

0 Centimeter 

Figure 6-50. "Graph Size" 

6.4 GTEMPl ERROR HANDLING 

When data in any Input Data Window, such as the Survey Data Input Window, are outside the 

appropriate range of values and the user attempts to close the window, the GTEMPl error checking 

routine locates the error. The application then displays an error message explaining why the data are 
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not acceptable. The user can ignore the error message and close the window, even though data in this 

window are in error. This enables the user to edit and view different Input Windows without having to 

have one completed before going to another. 

Calculation can only be initiated from the Project Window. If any invalid data are found at this 

time, the application displays an error message stating in which Input Window the data are located and 

why the data are wrong. Figure 6-51 shows some of the error messages. 

Figure 6-5 1. Error Messages of GTEMPl 

. ~ ~ . %  
~ ~ ~~~~~ 

. When an error message appears, click <OK> or press <ENTER > to return to the Project 

window or individual Input Window. 
~~~ - - ~~~ 

~ 

6.5 TOOLBAR 

Tool bar buttons are command buttons at the top of each window which let the user access the 

menu command items quickly and easily. The functions of these command buttons on the tool bar are 

equivalent to those of some menu commands. Explanation of these commands and their relation to the 

menu commands are: 

1 - Same as [New Project] or [New] 

2. - Same as [Open Project ...I or[OWn File ...I 

3 .  - Same as [Save Project] or [Save] 

4. - Same as [Print Project ...I or [Print. ..I 

5 .  1 - GO to previous Window 

B 
7. i - Go to WDI Window 

8. - Go to SDI Window 

10. - Go to PDI Window 
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7. Example Run 

7.1 OVERVIEW 

This chapter presents a complete example run of GTEMP1. The input project file WTTEST1 .GTE 

will be run to familiarize the user with program operation. The user should become familiar with: 

Menu operation 

Displaying and printing input data 

Displaying and printing output data 

- z7,7,2, EXAMPLE CASE 

_ Figures 7-1 to 7-5 present a print out of input data for this case. The data shown are from the 

supplied data files: "WTTESTl.GTE," "WTTESTl.WD1," "WTTESTl.SD1," "WTTESTl.GT1," and 

-"W-TTESTl.GP1." 

I 
Wellbore Thermal Simulation Model 

I 
I I 
I .................................. .................................. I 
I I 
I I 
I [ Project Data Input 1 I 
I I 
I Project File Name: C: \GTEMPl\WTTESTl .GTE I 
I I 
I Flowing Model = Liquid Production I 
I I 
I WDI File Name: WTTEST1. WDI I 
I SDI File Name: WTTEST1. SDI I 
I TDI File Name: WTTEST1. GT1 I 
I PDI File Name: WTTEST1. GP1 I 
I 
I Unit: English 

I 
---------em---- --------,--,,,, End of GTE file ============== I 

L - - - - - - - - - - - - - - - - - - - - - - - - - - A  
Figure 7-1. Project Data Input of the Example Case 
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Wellbore Thermal Simulation Model 

[ Well Data Input 1 

WDI File Name: WTTEST1.WDI 

Company Name : Maurer Engineering Inc. 
Project Name : GTEMP1.0 
Well Name : EXAM- 1 (Inclined well) 
Well Field : NONE 
Well City / State : Houston, Texas 
Date : April 10, 1995 
Comments : Liquid Production 

--------------- --------------- End of WDI file ============== 

Figure 7-2. Well Data Input of the Example Case 

===C======-=========CI=======l=l======= 

Wellbore Thermal Simulation Model 

=======PI=========P=====*==P=PPPPE 

[ Survey Data Input I 

SDI File Name: WITEST1.SDI 

Station Ueasured Depth 
(ft) 

Inclination Azimuth 
(Dec. ) (Dec. ) 

--------------- --------------- End of SDI file ==I=========== 

Figure 7-3. Survey Data Input of the Example Case 

01997 Maurer Engineering Inc. 



Wellbore Thermal Simulation Model 

[ Tubular Data Input I 

I TDI File Name: W'ITESTl.GT1 I 
I - - - - - - - - - - - - - - -  Tubing and casing properties - - - - - - - - - - - - - - -  I 
I Material Conductivity Heat Capacity Density I 
I (Btu/hr-fta- OF) (Btu/lbm-OF) (lh/fta) 1 
I Steel Casing/DP 26.10 0.11 490.00 - - - - - - - - - - - - - - - - - - -  Tubing configuration - - - - - - - - - - - - - - - - - - -  I 
I Tubing ID OD TOP Bottom Cement I I NO. (in) (in) (ft) (ft) (ft) 

5000 
I 

i 1 3.960 4.500 0 5000 I 
I - - - - - - - - - - - - - - - - - - -  Casing configuration - - - - - - - - - - - - - - - - - - -  I 
I Casing ID OD Depth Cement Interval 1 

- I NO. (in) (in) (ft) (ft) 
- - 1 8.680 9.630 5000 2200 

I 
I 2 12.350 13.380 3000 2200 I 
I 3 19.120 20.000 1000 1000 I 
i 4 29.000 30.000 100 100 I 

. . . . . . . . . . . . . . . . . . . . . . .  Well gemetry . . . . . . . . . . . . . . . . . . . . . . .  I 
i Initial Depth Bore Diameter I 
I 0x1 (in) 
I 5000 31.000 

I 
I 

I . . . . . . . . . . . . . . . . . . . . . .  Rock Properties . . . . . . . . . . . . . . . . . . . . . .  I 
1 (One-Layer Rock Formation) I 
I Material Conductivity Heat Capacity Density Vertical Depth I 
I (Btu/hr- fta- OF) (Btu/lh-OF) (lh/fta) 0%) I 
[Shale (default) 0.92 0.30 140.00 5000.00 I 
I - - - - - - - - - - - - - - - - - -  Geothermal temperatures - - - - - - - - - - - - - - - - - -  I 
1 Surface Temperature Bottom Temperature I 
I (OF) (OF) 

70.00 150.00 
I 

I I 
I . . . . . . . . . . . . . . . . . . . . . . . . . . .  Grid . . . . . . . . . . . . . . . . . . . . . . . . . . .  I 
I Radial Grid Number Max Radial Distance Vertical Grid Size 

(ft) 0x1 
I 

I 10 50.00 200.00 I 
I I 
I - - - - - - 2-z=~=2=z=z=-E~-~ff TDI file ===E==========- - - - - - - 1 

Figure 7-4. Tubular Data Input of the Example Case 
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.Wellbore Thermal Simulation Model 

---^-----------------------I-------- ........................... ------ 
[ Parameter Data Input I 

PDI File Name: WTTESTl.GP1 

I _ _ _ _ _ _ _ _ _ - _ _ _ _ _  Set Variables at Time = O(DAY)--------------- I 
1 Plowing Model = Liquid Production 

Fluid #1 Injection Into Tubing 
I 

I Fluid #l In Well I 
I Inlet Temperature = 150.0("F) I 
I Flow Rate = 15.0(gal/min) I 
I Time To Change Data = lO.O(day) I 

~ . .- ~ ~::~ ~~~ 

I - - - - - - - - - - - - -  Set Variablee at Time = lO.O(DAY) - - - - - - - - - - - - -  I 
1 Flowing Model = Liquid Production I 
I 

~ - Fluid #1 Injection Into Tubing I 
~~ ~ ~ ~~ 

~ - I Fluid #1 In Well 
Inlet Temperature = lSO.O(OF) 

I 

~ ~ ~ 

I 
Flow Rate = 150.0 (gal/min) I 

.. , ~- 

,~ ~- 1 
Time To Change Data = 20.0(day) I 

I I 
- - I _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _  Wellbore fluid properties - - - - - - - - - - - - - - - - -  

Density P.V. Y.P. k 
I 

I Type 
NO. (lbm/gal) (cp) (lb/lOOftl) (lb-s^n/ft2) 

l 
I 1 10.00 15.00 5.00 X X I 

- I I 
I NOTE: P.V. = Plastic Viscosity 

Y.P. = Yield Point (for Bingham Fluid) 
I 

I 
k = Consistency Coefficenty I 

I n = Exponent of Power Law (for Power Law Fluid) I 
I I 
I _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _  Wellbore Initial State - - - - - - - - - - - - - - - - - -  

Fluid #1 In Tubing - Tubing Annulus 
I 

I 
Fluid #1 In Casing - Casing Annuli I 

I I 
I I 
I -=z=E=5=E=E=E=L=-E~d - - - - . i - - - - - - - - - - - - - l  of PDI f lle ============== 

Figure 7-5. Parameter Data Input of the Example Case 

Use of these data generates the example results presented in this manual. The WTTESTl data are 

for illustration only and should not be taken as preferred values. 

Start GTEMPl using the methods described in Section 4.3. 

In the following sections, the procedures are explained step by step. 
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- 
rC4 

7.3 INPUT WINDOWS - 
Select "Qpen Project ..." from the File menu in the Project Window. Retrieve the project file 

W'M'ESTl .GTE in C:\GTEMPl. After the user completes the dialog in the Project Window, other Data 

- Input Windows can be displayed as shown in Figures 6-3, 6-4, 6-5, 6-6, and 6-11. Please refer to them. 

- 7.4 OUTPUT WINDOW AND P m T  OUTS 

Selecting "&irt" from the Bun menu in the Project Window launches calculation. The calculating 

percentage complete indicator shows the ongoing status of the calculation. - 
After calculation is complete, the Output Window and its "child" windows are shown in Section 

- 6.1.3. The figures and text files displayed here are output through the printer through corresponding 

windows. 
- 

- 1. Thermal Analysis Report (Figure 7-6). 
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--------------------------------- 
I _ _ _ - _ _ _ _ _  _ _ _ _  R vs. T Data at Tirne=lO(day), MD=O(ft)------------- 1 
I  I 

R (in) 
1.0 
3.3 
15.5 
30.4 
51.7 
82.5 
126.6 
190.0 
281.1 
412.1 
600.2 

I  =============== End of R vs. Temperature Data ============== I 
I  I 

- - - - - - - -  MD vs. T in Tubing and Annulus at Time=lO(day)--------- 1 
I  

Measured Depth (it) Tubing (T(OF) ) Annulus (T(OF) ) I  
I 0 118.6 70.0 

200 124.0 112.9 
I  

400 126.0 115.2 I  
600 128.0 117.4 I  
800 129.9 119.7 I  
1000 131.6 122.5 
1200 133.3 124.5 

I  
I  

1400 134.9 126.4 I  
I  1600 136.4 128.3 
I 

I  
1800 137.8 130.1 I  

I  2000 139.2 131.8 
2200 140.5 133.5 

I 
I 

2400 141.8 135.2 I  
I  2600 142.9 136.7 I  
I 2800 144.0 138.3 1 
I 3000 145.0 139.9 

3200 145.9 141.2 
I 

I  
3400 146.7 142.5 I 

I  3600 147.5 143.7 I  
I  3800 148.1 144.8 

145.9 
I  

I 4000 148.7 
4200 149.2 146.9 

I  
I 4400 149.5 147.8 I  
1 4600 149.8 148.6 I  
I 4800 149.9 149.3 

150.0 150.0 
I  

I 5000 
--==-----El---- -- ----- ---- End of MD vs. Temperature Data ============== I  

L - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - J  
Figure 7-6. Thermal Analysis Report Print Out 
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2. Wellbore Schematic (Figure 7-7). 

Figure 7-7. Wellbore Schematic Print Out 

3. Radial Temperature Distribution (Figure 7-8). 

Figure 7-8. Radial Temperature Distribution Print Out 

T VP. R 8tMD -3188(R) at Flow Time=lO(day) 

I50 

(T 14~1<- I3OT 120 -- 
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4. Vertical Temperature Distribution (Figure 7-9). 

T ("n 
110 120 130 140 150 160 
0 

-'OmT 
- 2 m  f 

MD (fi) 

-3000-- 

- 4 m - -  

-5m- 

MD vr. T in Tubing tt Flaw T ~ m r  1 O(day) 

Figure 7-9. Vertical Temperature Distribution Print Out 
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5 .  Three-Dimensional Temperature Report (Figure 7-10) 

Wellbore Thermal Simulation Model Output Data 

I ---------=--=- --------- -- - I I I I P I L P I = I I I I I = = = = = I - = = = = = = = = = = = = = =  I 
I I 
I - - - - - - - - - - - - - - -  Set Variables at Time = O(DAY)--------------- I 
I Flowing Model = Liquid Production I 
I Fluid #1 Injection Into Tubing I 
I Fluid #1 In Well 

Inlet Temperature = 150.0 (OF) 
I 

I Flow Rate = 15.0(gal/min) I 
I . -- Time To Change Data - lO.O(day1 I 

- 

I - 
J . . . . . . . . . . . . . . . . . . . .  I 

Temperature Distribution-------------------- I 
IMc~asured Depth Radius 1 
I 1.0 3.3 15.5 30.4 51.7 600.2 I 

- I -  
0 118.6 70.0 70.0 70.0 70.0 

I 
I 70.0 

200 124.0 112.9 90.8 81.4 75.9 73.2 I 
I 400 126.0 115.2 93.6 84.5 79.0 76.4 I 

- h  
I 600 128.0 117.4 96.4 87.5 82.2 79.6 I 
I 800 129.9 119.7 99.0 90.4 85.3 82.8 

1000 131.6 122.5 100.5 92.8 88.2 86.0 
I 

I 
1200 133.3 124.5 103.2 95.7 91.3 89.2 I 

- I 1400 134.9 126.4 105.9 98.7 94.5 92.4 I 
I 1600 136.4 128.3 108.5 101.7 97.6 95.6 I 
I 1800 137.8 130.1 111.2 104.6 100.7 98.8 
I 2000 139.2 131.8 113.8 107.5 103.8 102.0 

I 
- 2200 140.5 133.5 116.4 110.5 106.9 105.2 I 

I 2400 141.8 135.2 119.0 113.4 110.0 108.4 I 
I 2600 142.9 136.7 121.6 116.3 113.1 111.6 

2800 144.0 138.3 124.0 119.1 116.2 114.8 
I 

- I 
3000 145.0 139.9 126.3 121.9 119.3 118.0 

I 
I 3200 145.9 141.2 128.8 124.8 122.4 121.2 I 
I 3400 146.7 142.5 131.2 127.6 125.5 124.4 I 
I 3600 147.5 143.7 133.7 130.5 128.6 127.6 

3800 148.1 144.8 136.1 133.3 131.6 130.8 
I 

I 4000 148.7 145.9 138.5 136.1 134.7 134.0 I 
I 4200 149.2 146.9 140.9 138.9 137.8 137.2 1 
I 4400 149.5 147.8 143.2 141.7 140.8 140.4 1 

4600 149.8 148.6 145.5 144.5 143.9 143.6 
I 4800 149.9 149.3 147.8 147.3 147.0 146.8 

I 
I 5000 150.0 150.0 150.0 150.0 150.0 150.0 I 
1 5200 153.2 153.2 153.2 153.2 153.2 153.2 I 
I I 
I Note: Measured Depth in (ft) ; Radius in (in) ; Temperature in (OF) I 

========E=PP=== End of 3D Temperature Data t n = m = = = = = = = = = =  
I - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - J  

Figure 7-10. Three-Dimensional Temperature Report Print Out 
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6. Three-Dimensional Temperature Distribution (Figure 7-1 1). 

Figure 7-1 1. Three-Dimensional Temperature Distribution Print Out 

7. Temperature in Tubing and Annulus (Figure 7-12). 

Figure 7-12. Temperature in Tubing and Annulus Print Out 
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8. Temperature in Tubing (Figure 7-13) 

Figure 7-13. Temperature in Tubing Print Out 

9. Temperature Versus Time in Tubing Report (Figure 7-14). 
I _ _ _ _ _ _ _ _ _ _ _ - - - - _ - - - - - - - - - -  

1 

I - - - - - - - -  Temperature ve. Time in Tubing at MD-lOOO(ft)-------- I 
Time (hour) 

0.240 
0.540 
0.915 
1.384 
1.970 
2.702 
3.618 

Temperature (OF) 
86.0 
89.6 
93.1 
96.6 
100.0 
103.4 
106.8 

Figure 7-14. Temperature Versus Time in Tubing Report Print Out 
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10. Temperature Versus Time in Tubing-I (Figure 7-15). 

Tempemre vr. Time in Tubing at MD=1000 (R) I 

Figure 7-15. Temperature Versus Time in Tubing-I Print Out 

90.- 

Temperature Versus Time in Tubing-I1 (Figure 7-16). 

I 

I 

Tanperamre vs. Time in Tubing u MD-2WO (A) 

80 I 
0 50 100 150 200 250 

T~me (hour) 

Time (hour) 

Figure 7-16. Temperature Versus Time in Tubing-I1 Print Out 
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12. Undisturbed Geothermal Temperature (Figure 7-17). 

Rock Formation Geothermal Temperature T (OF) i 

7.5 GTEMPl QUICK START 

- Use the following procedure to get started in GTEMP1: 

Install: 

- 1. Start Windows (3.0 or a later version). 

2. Insert the disk in drive A:. 

- 3. In the File Manager, choose Bun from the File menu. 

4. Type A:\setup and press <ENTER > . - 
5. Follow on-screen instructions. 

01997 Maurer Engineering Inc. 

I 

Figure 7-17. Undisturbed Geothermal Temperature Print Out 
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Run: 

1. Double-click the GTEMPl icon in the "DEA Application Group" Window. 

2. In the Project Window, choose "Qpen Project ..." from the File menu. 

3. From the "Open GTE File" dialog box, click drive C: in the drive list box, double-click 

the GTEMPl sub-directory, click "WTTEST1.GTE" in the file list box, then click OK. 

4. Click on menu items in the Input menu to view each of the data input windows (WDI, 

SDI, TDI, and PDI). 

5. Click "start" from the Run menu in the Project Window. 

6. View the output "child" windows tiled in the Output Window. 

~ ~ ~ 

~~ ~ 
~ ~ .~ 7. To print out the text report or graph, activate the desired "child" window, select "Print.. ." 

-- 

- 
from the File menu. 

~ ~ 

8. Choose "Return" from the File menu to return to the Project Window where the application 
~ . ~~ ~~ ~ . 

~~ ~7~ 

~ can be terminated. 
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9. Bug Report or Enhancement Suggestion Form 

Name: Company: 

- Address: City: State: 

Phone No.: Fax No.: Date: 

BugIProblem Report Enhancement Suggestion - 
- Program Name and Version Number: 

- - - 

- BuglProblem Description or Enhancement Suggestion: 

- 
Regarding the Bug Report, please answer the following questions: - Brand: 
- - 

Ch~p:  286 17 386 486 Pentium 

Type: Desktop Laptop Notebook Other 

RAM : MB m: MHz 

Math-Coprocessor p r a a :  yes  No Unknown 

Printer Type: (for printing error only) 

Plotter: (for plotting error only) 

Within Network System: 17 yes  No Type: 

Video Type: EGA VGA SVGA Mono LCD 

Video Card Ram: (video problem only) 

Svstem 

MS-DOS Version No.: MS-Windows Version No.: (Windows Application) 

OS2 MS-Windows NT Version No.: 

Other 

DataIParameters Cw&gJ3ug 

Will be mailed on diskette Will be faxed Attached None 

Other Comments: 

Please send or fax to: 

Lee Chu 
MAURER ENGINEERING INC. 

2916 West T.C. Jester 
Houston, TX 77018-7098 

Ph: 7131683-8227 Fax: 7131683-6418 
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Appendix A 
International Keyboard 

All DEA computer programs developed at Maurer Engineering Inc. are written using the "U.S." 
Keyboard. Under thls keyboard, the "1000 separator" is a comma, and the "decimal separator" is a 
period. Thus, the number one thousand, two hundred and thirty-four and twenty-two1100 is written 

Numbers input into the programs are filed in this format. 

Problems have occurred for some of our Participants who use the "International Keyboard," as 
is common in Europe and South America. Here, the same number would be written 

. . . ,  . .. 1.234,22 
. ~. "'. 

Here,-the "1000 separator" is a period, and the decimal separator is a comma. 

European and South American users find that their computers garble input data being loaded into 

our DEA programs. 
- 

This problem can be readily solved by changing the Windows "numbers format" from the 
International to the U.S. format. This is accomplished as follows: 

1. From the DOS prompt, type 

WIN <ENTER> 

to open WINDOWS. 

2. From the Menu bar, choose "Window"either by clicking on "Window" or keying in 

This brings down the "Select Window" menu screen, as shown in Figure A-1 
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Figure A-1 . Windows Menu Bar 

, . 
3. Select "Main" by clicking on "Main" and then clicking on the "OK button. This brings down 

,.,., . . 
., the "Main" menu screen, as shown in Figure A-2. 

-- 

Figure A-2.Main Menu SG 

4. Select the "Control Panel" icon from the "Main" menu screen. This is done by pointing the 
mouse to this icon and double clicking. This brings up the "Control Panel" menu screen, as 
shown in Figure A-3. 
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1 Figure A-3. Control Panel Menu Screen 

- - -  
5. Select the "International" icon from this menu screen by pointing to it with the mouse and 

double clicking. This brings up the "International" Menu screen, as shown in Figure A-4. 

Rognm Manager -[Main) 

- - 

Figure A-4. International Menu Screen 

6. In the lower right hand corner of the "International" menu screen is the ' 
If the number under the words "Number Format" is 

1,234.22 

The DEA programs will run. Click on the "Cancel" button in the upper 
and back out to the "Windows"menu screen to run your program. 

"Number 

right of 

Format." 

this screen 
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If the number under the words "Number Format" is 

1.234,22 

it must be changed before a DEA program will run successfully. 

7.  To change "Number Format," click on the "Change" button in the "Number Format" box on 
the screen. This will bring up the "International - Number Format" screen. The "1000 

Separator" box will be highlighted, as shown in Figure A-5. Key in 

<DEL> , 

This will erase the period from the "1000 separator" box and replace it with a comma. 

Figure A-5. International - Number Format Screen 

8. Either point the mouse to the box labeled "Decimal Separator" and click, or key in 

< TAB > 

This will highlight the "Decimal Separator" box. 

9. Key in 

<DEL> . 

This will erase the comma from the box and replace it with a period. 
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10. Either key in 

<ENTER > 

or point the mouse to the "OKUbutton in the "International - Number Format" box and click 
This will return you to the "International" menu screen, as shown in Figure A-6. 

Figure A-6. International Menu Screen, with Correct Number Format 

11. Click on the " O K  button to return to the "Main" menu screen. 
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